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See the way Marketing & Sales Suite for Magento 2 extension works.

Guide for Marketing & Sales Suite by
MageWorx for Magento 2

Equip your store with a set of automated marketing & sales tools. Streamline and personalize your
marketing efforts to boost your sales and retention.

e Show customer reviews and social-proof notifications

e Automatically collect feedback with popups and email reminders
» Assign reward points for specific activities

¢ Give personal discounts to particular customers

e Display products stock status and recent sales

e Configure countdown timers for limited-time offers

If you are installing Marketing & Sales Suite from the package, please mind installing the additional
libraries via Composer with the following commands:

composer require geoip2/geoip2 ">=2.9 < 3"
composer require piwik/device-detector "@stable"

Configure recent sales notifications display

Social Proof & FOMO (Recent sales notifications) extension is designed to increase social proof to your
store by displaying the recent sales and trending products. To enable or disable the functionality
globally please go to Stores - Configuration » Mageworx -» Marketing Suite. By default, it is set
to Yes.

Social proof
To add or modify the campaigns for the sales pop-up, go to Marketing - Social proof.

.Enable_- Vas =

Manage campaigns

In order to add or edit social proof campaigns, go to Marketing — Marketing Suite — Social
Proof.
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Social proof

Actions -

3 records found

Recent Sales - All

Products

et

3 Jacket Sales

Each campaign can be shown as a pop-up or displayed as HTML text on the product page. You can set
this using the 'Display Mode' setting.

Display mode = pop-up:

Product Views

Created At

Event Type

Recent sales | Feb 3, 2021
10:39:08 AM
Views Feb 3, 2021
(Popularity) 10:41:17 AM
Recent sales | Feb 3, 2021

10:46245 AM

T Filters

20 -

Feb 3, 2021

L O

per page

12:16:03 PM

Feb 3, 2021

12:15:04 PM

L demouser ~

Add New Campaign

Default View -

Status

Enable

Enable

(%]

3 Enable

ﬁ Columns -

of 1

Select -

Select -
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Jackets

Shopping Options B2 B2 11 Items SortBy | Position ~v |t
CLIMATE ‘*-"'

COLOR e

ECO COLLECTIO
M

ERIN RECOMME ™

NDS
MATERIAL e
MEW e
F
PATTERMN o Proteus Fitness Jackshirt Montana Wind Jacket Jupiter All-Weather Trainer
As low as $45.00 A 3 Reviews ok i 3 Reviews
PERFORMAMNCE
FABRIC As low as $40.00 Az low as $56.90
¥5 L [X] | Wil
PRICE e - - - S g Y] 1 X1 W5 5 (1] 1 ¥l
i . M. N .-
SIZE ~
hin cndaon d Kin 0

purc SBLC
STYLE e | |

& Overnight Duffle

# & 1 dayago
Aarmmmara Deadoete :

Display mode = text:
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Fusion Backpack

i 3 Reviews Add Your Review

$49.00

Regular
Price

$59.0

Qty

Add to Cart

¥ This product was RULEVELEFS BT for last day

W ADD TO WISH LIST «ls ADD TO COMPARE

Each campaign can be one of two types:

* Recent sales - these campaigns will display the sales of certain or all products, which were
purchased within a certain period from the current date.
* Views - these campaigns display the number of views of the products for a certain period.

To add a new campaign click on “Add new campaign”. The adding new campaign flow has 3 steps,
where you should choose the display mode (1st step), the event type (2nd step), and set the
campaign details. Note both these parameters (display mode and event type) cannot be changed
once the campaign is created.

The General section of the campaign settings:
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New Campaign L demouser -

Display mode Event Type Campaign

Information
CAMPAIGN General
INFORMATION
General # Mame +* | Recent Sales - All Products
Display On (Products) Status Disable |
Display On (Categories) i
Store Views * All Store Views
Main Website
Display On (CMS Pages)
Main Website Store
a ) Default Store View
Restrictions P
Design & Position Customer Groups * NOT LOGGED I
General
Wholesale
Retailer
4
Restrict to current Mo
product ’
Period i

Name - the internal name of the campaign. It is visible in the back-end only.

Status - the status of the campaign.

Store View(s) - you can choose the store views you want to display the campaign on.

Customer groups - you can choose the customer groups you want to display the campaign

for.

e Restrict to current product - this toggle restricts the statistics, gathered by a campaign, to a
certain product, which is viewed by a customer. This setting is always enabled for Views
campaigns.

* Period - this setting defines a period in days during which the recent sales or views activity

should be gathered.

Example

amasty


https://amasty.com

2025/03/18 21:38 7/60 Guide for Marketing & Sales Suite by MageWorx for Magento 2

Let's assume you created the pop-up recent sales campaign with 7 days period and enabled the
‘Restrict to current product’ toggle. If a customer opens product A in your store, he/she will see
the pop-up with the recent sales of this particular product, which were placed within 7 days from the
current date. l.e. the previous purchases of this product A made within 7 days will be shown by such
campaign. The same behavior for Views campaigns.

(%)

Start Delay

Auto Close in
be closedhided automatically.

Max Mumber of
Pop-ups per Page
Load =

Display On * Product Pages
Category Pages
CM5 Pages

Display On Mobile o
Priority

Remove "Verified (
by MageWorx

e Start Delay - this setting sets a delay in seconds after page loading to display a pop-up or
HTML text block.

e Auto Close in - this setting sets the time in seconds, when a pop-up or HTML text block will be
closed/hidden automatically. This time is calculated from the time when the pop-up or text
block appears.

* Max Number of Pop-ups per Page Load - this setting sets the max number of pop-ups
displays per each page load. l.e. if the campaign retrieves 10 recent sales and this setting is set
to 5, the customer will see 5 pop-ups shown one after another per 1 page load. This setting is
applicable to the Recent Sales campaigns only.

» Display On - this setting defines the page types, where the campaigns should be shown. You
can choose to display the pop-ups on product pages, categories, and/or CMS pages. This setting
is applicable to 'Pop-up - Recent Sales' campaigns only. This option appears if the 'Restrict to
current product' setting is disabled.

» Display on Mobile - this setting allows you to disable the campaigns for mobile traffic.

e Priority - this setting defines the priority of each campaign if multiple campaigns have the
same conditions. The campaign with higher priority will be executed.

* Remove “Verified by MageWorx” - this toggle allows you to hide the “Remove “Verified by
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MageWorx” text below the pop-up. You can also edit this message in the design template
directly in the back-end. This setting is applicable to 'Pop-up' campaigns only.

The following sections appear only for Pop-up - Recent Sales campaigns if the 'Restrict to current
product' setting is disabled' and at least one value is selected in the 'Display On' multi-select. These
sections allow you to determine the pages, where the campaign will display the pop-ups, i.e. when the
customers open these pages, they will see the marketing campaigns.

Recent Sales - All Products 4 demouser -
€« Back Delete Campaign Reset Save and Continue Edit Save Campaign
CAMPAIGN Display On (Products)
INFORMATIOMN
Display mode Assign Type All products v

Specific products
By conditions

Bvent Type

General  #

Display On (Products)

Display On {Categaories)

Display On (M5 Fages)

Restrictions

Design & Position

e Display On (Products) - this section allows you to choose the products the campaign should
be applicable to. You can choose to apply the campaign to all products, manually selected

products, or add the dynamic conditions to apply the campaign to all products, which match
necessary conditions.
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Recent Sales - All Products L. cemosser ©
< Back Delete Campaign Reset Save and Continue Edit Save Campaign
CAMPAIGM Display On (Categories)
INFORMATION
Display mode Assign Type | Specific categories ¥ |
Event Type Categories | Gear x || Bags x|
| Fitness Equipment = || Watches =
e | Training /” Men .x” Tops .x|
| Jackets = ” Hoodies & Sweatshirts
Display On (Products)
| Tees = || Tanks = || Bottoms :-cl
Display On (Categories) | Pants = || Shorts = || Women =
| Tops = || Jackets .x|
Display On {CMS Fages) | Hoodies & Sweatshirts = ” Tees f|
| Bras & Tanks x” Baottoms xl
Restrictions | Pants = || Shorts = || Promotions =

ale :-c” What's New \| -

Design & Position

* Display On (Categories) - this section allows you to choose the categories you want to
display the campaign on. You can choose all products or manually select the necessary
categories.
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Recent Sales - All Products X demouser ~
< Back Delete Campaign Reset Save and Continue Edit Save Campaign
CAMPAIGN Display On (CMS Pages)
INFORMATION

Display mode Assign Type All pages o

Event Type Specific pages

General  #

Display On (Products)
Display On (Categories)
Display On (CM5 Pages)
Restrictions

Design & Position

» Display On (CMS pages) - this section allows you to choose the CMS pages you want to

display the campaign on. You can choose all pages or manually select the necessary CMS
pages.

The Restrictions section allows you to exclude specific products to be processed by the Recent Sales
campaigns. l.e. the statistics of the items matching these conditions won't be gathered by the
campaigns. You can add the dynamic conditions here:
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Recent Sales - All Products A demouser ~
“ Back Delete Campaign Reset Save and Continue Edit Save Campaign
CAMPAIGM Restrictions
INFORMATION
Display maode __ Conditions (don't add conditions if campaign can display the activity of any _
’ product(s])

Event Type If ALL of these conditions are TRUE :
! Attribute Set is Downloadable @

General @

Display On (Products)

Display On (Categories)
Display On (CMS Fages)
Restrictions

Design & Position

The Design section allows you to choose a position of the pop-up on the screen and select a design of
the pop-up or the text block.
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Recent Sales - All Products A demouser ~
“ Back Delete Campaign Reset Save and Continue Edit Save Campaign
CAMPAIGN Design & Position
INFORMATION

Position -

@

Display mode

Event Type

. L]
General N

Bottom Left
Display On (Products)

Display On (Categories)

Display On (Ch5 Fages)

Restrictions

\
-

Templates -

G

Design & Position

The templates can be chosen in the 'Templates' tab. There are more than 40 ready templates for the

pop-up and text campaigns. You can also edit any design template in the text area below or create
your own template.
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ol Templates

Re

t # Mid rise ripped denim shorts

mAgEwGT e

Mid rise ripped denim shorts

i

[CT= T

i
)

# Mid rise ripped denim shorts

]

mAgEwGT e

# Mid rise ripped denim shorts

MAGEWET

The following variables are available:

Views campaigns

X

Cancel Load Template

# Mid rise ripped denim shorts

]

mAgEwG e

# Mid rise ripped denim shorts

i

MAGEWGT

=4

Mid rise ripped denim shorts

mAgEwE e

# Mid rise ripped denim shorts

MAGEWTT 2

#8

e [product.name] - outputs a name of a given product.

[count_customers]
[count_times]

Recent sales campaigns

[product.image] - outputs an image of a given product.

[product.url] - outputs URL of a given product.

[product.rating_summary] - outputs a rating summary of a given product.
[product.rating_stars] - outputs the rating stars of a given product.
[period] - outputs a period in days, specified for the current campaiing.

e [product.name] - outputs a name of a given product.
e [product.image] - outputs an image of a given product.
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e [product.url] - outputs URL of a given product.

e [product.rating_summary] - outputs a rating summary of a given product.

e [product.rating_stars] - outputs the rating stars of a given product.

e [customer.name] - outputs a customer name (first name and last name).

e [customer.location] - outputs a full customer location (country, city), determined by the GeolP
functionality.

e [customer.city] - outputs a customer city, determined by the GeolP functionality.

e [customer.country] - outputs a customer country, determined by the GeolP functionality.

e [customer.region] - outputs a customer region/state, determined by the GeolP functionality.

e [last_purchase] - outputs how many days passed since the date of the last purchase date of a
given product.

Configure stock statuses display

To tweak the stock status progress bar display on the front-end, adjust its general settings, and
specify follow-up messages to be shown on the storefront. Please go to Stores -» Configuration -»
Mageworx -» Marketing Suite.
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Stock Status
Enable Vs -
This setting enables/disables the stock bars on the front-end
Dizplay On
P _3.-' aw] Products
Categaories
Search Results
s
This setting allows you to display the stock status on the chosen pages
Display "In Stock” Vs -
messages -
[stare view]l  |f enabled, the "In Stock” message will be shown on the front-end.
In Stock [stock] items in stock
message
[stare view]  This message will be shown on the front-end, when a product stock is more than “Low Stock Level”.
Display "Low Vs iy
<2
Stock” message
[stare view]l  |f enabled, the “Low Stock” message will be shown on the front-end.
" M, " . - .
Low Stock™ | 10 ceock is getting low. [stock] items left in stock
message
[store view]  This message will b shown on the front-end, when a product stock triggers the "Low Stock Level”
Low Stock” level |\ «otify for Quantity Below” setting v

Display "Urgent
Stock” message

"Urgent Stock”
message

"Urgent stock”
value

This semting defines whether to use native product setting to set the "Low Stock” value or to specify a custom value. If the option to

use Magento 2 setting is selected, th enszion will check the stock value specified in the "Motify for Quantity Below” setting in the
“Advanced Inventory” window fior each product.
es T

If enabled, the "Urgent Stock” message will be shown on the front-end.

This product is almost sold out. Hurry up to order! [stock] items left in stock.

This message will be shown on the front-end, when a product stock triggers the "Urgent Stock Level™

5

This setting defines a stock level, when the urgency flow should be triggered.

¢ |In the Enable field, select No to disable stock status display functionality. By default, it is set to

Yes.

In the Display On box, select one or more pages to display the stock status on. You can press

and hold the ctrl key to select multiple options.

In the Display “In Stock” message field, select No to disable the in-stock message display on

the front-end. By default, it is set to Yes.

In the “In Stock” message box, type custom text with the [stock] variable. This message will

be displayed on the front-end when the stock level is not low.

In the Display “Low Stock” message field, select No to disable the low stock message

display on the front-end. By default, it is set to Yes.
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* In the “Low Stock” message box, type custom text with the [stock] variable. This message
will be displayed on the front-end when the stock level is low.
e Click the “Low stock” level arrow to see more options, and then select one of the following:
1. Select Custom “Low Stock” value. to use a custom low stock value.
2. Select Use “Notify for Quantity Below” setting to make the extension check stock value
for each product in the Advanced Inventory window.
* In the Display “Urgent Stock” message field, select No to disable the display of the urgent
stock message on the front-end.
¢ |In the “Urgent Stock” message box, type custom text with the [stock] variable. This
message will be displayed on the front-end when the product stock value reaches the urgent
level.
* In the “Urgent stock” value box, specify the stock level value that should trigger the urgency
flow. By default, it is set to 5.

Configure product reviews & reminders

The module allows the store admins to expand the default Magento 2 product review functionality by
introducing new blocks and brings the possibility to automatically collect customer feedback with the
help of popup and email reminders.

Fine-tune review settings

To adjust review settings, you can specify them regarding different products. It allows you to display a
customer location for the reviews, to enable different options, to add a reward message, and to let
your customers add their images to the reviews. Please, navigate to Stores - Configuration -
Mageworx - Extended Review.
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Review Settings

Display Images Yes -

Allow Images Uploading

This set NE 3l0Ws Your cCustomers i add their Mmageas 1o INe reviews.

Image 5|z_e. PX | 300

This sem £ width size of the thumbnails related to the
review i

Display Location o .
This satting allows you to display a customer location for the reviews.

N "

Enable "Helpful - -

This setting adds the "Helpful” option for each review
Enable Recommend Option - .

s product” feature for the

Enable Pros & Cons

Yes v
This setft ng enablasz tne functionality to h ERdIENT tNee Main product
advantages and dizad antages, wnen submitt NE the reviews.

In the Display Images field, select No if you do not want to display images. By default, it is set
to Yes.

In the Allow Images Uploading field, select No if you do not want to allow the customers to
add their images to the reviews. By default, it is set to Yes.

In the Image Size, px field set the width size of the thumbnails related to the review images.
In the Display Location field, select No if you do not want to display a customer location for
the reviews. By default, it is set to Yes.

In the Location Template field, define how the location is shown on the front-end.

In the Enable “Helpful” field, select No if you do not want to add the helpful option for each
review. By default, it is set to Yes.

In the Enable Recommend Option field, select No if you do not want to enable “I recommend
this product” features for the reviews. By default, it is set to Yes.

In the Enable Pros & Cons field, select No if you do not want to enable the functionality to
highlight the main product advantages and disadvantages. By default, it is set to Yes.
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Enable "Verified customer” e -
= [ ==
This setting enables the functionality to add "Verified customer” label to
the reviews. The verified customer is determined by the purchases of the

Current product

-

Add privacy check-box

5 WOU 10 300 e required Cconsent cneck-0ox 1o a0dIing

-

Add points message

This setting allows you to add a reward message for "add new review” if

g this rule in the "Reward Points" extension (should be installed in

Reward Message | ro; [review_points] for review!

This setting allows you to specify a text, which should appear near the

Add review” buth

Characters limit in reviews 200
2 ViaWw =

This setting limits the number of characters of the text in the review on

the product page visible by default. If the number of characters of the

review exceeds this value, 'Show more’ / 'Show less' links will appear.

EAL LY

Characters limit in reviews widget S

This setting limits the number of characters of the review visible in the

widget by default.

¢ In the Enable “Verified customer” field, select No if you do not want to enable the
functionality to add the verified customer label to the reviews. By default, it is set to Yes.

e In the Add privacy check-box field, select No if you do not want to add the required consent
check box to add a new review flow. By default, it is set to Yes.

* In the Message field, specify a text, which should appear near the consent check box.

¢ |In the Add points message field, select No if you do not want to add a reward message. By

default, it is set to Yes.
¢ In the Reward Message field, specify a text, which should appear near the Add review button.

e In the upper-right corner, click Save Config.
Change filter settings

To adapt toolbar settings, you can choose the available filters and sorting for your customers. Please,
navigate to Stores —» Configuration - Mageworx - Extended Review.
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(=) Toolbar Settings

Filter Options
Your Country

With images

Verified customers

= el able filters for your
IZT0m 1=} TE 5oL ba
Sarting Options
&F Date
Rating
e
= SEming L E avallabie =0 1
IZT0m
Default Sort By | poec o
Default Sort Direction | ¢+ ac-ang ng v

Reviews per Page

Under Toolbar Settings, in the Filter Options field, select the available filters for your

customers.

In the Sorting Options field, select the available sorting for your customers.

In the Default Sort By field, specify the default sort. By default, it is set to Date.

In the Default Sort Direction field, specify sort direction. By default, it is set to Sort

Ascending.

¢ In the Reviews per Page field, enter the number of reviews that will be displayed per page. By
default, it is set to 10.

e In the upper-right corner, click Save Config.

Manage reviews

To view the reviews list please go to Marketing - User Content - All Reviews.
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Reviews A demouser =

Reset Filter

Actions b 347 records found 20 b per page 1 of 18 >

= . - Is Is .
T
Created Status Title Nickname Visibility Type Product Answer Recommend | Verified Action

347 Feb 2, 2021, Approved | Love this Veronica Customer | Luma Analog | 24- HiVeronica! Thank | Yes Yes Edit
6:43:39PM watch Watch WG03 you for your
stylish. W... i
seasonal sale is
soon!
Store View
339 Sep 16, 2020, Approved | Aregular Pearl This is in Main Guest Antonia WTOB Hi Pearl, thank you = ‘Yes Yes Edit
11:49:32 AM for me regular Website Racer Tank very much for your
rotation at Main feedback
the gym.Its | Website
ol Store
Default
Store View
340 Sep 16, 2020, Approved © Greatfit- Thalia Great fit - Guest Breathe-Easy @ WT09 Hi Thalia, thank Yes Yes Edit
11:49:32 AM love the v- love the v- Tank you so much for
neck neck design! your feedback. You
design!

made of den:
material.
let us know in case
of any guestions.

Here right from the grid, you can Edit, Approve/Disapprove or Answer any review.

Create an email reminder

To automatically send emails with a request to review an offering, set up email reminders. You can
configure email templates and adjust creatives as you wish. Please go to Marketing -» REview
Reminders - Manage Reminders.
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Reminders L demouser -

Mew Popup Reminder Mew Email Reminder

¥ Filters 4> DefaultView - I Columrs -

Actions = 4 records found 20 = | perpage ’ af 1

Type Period | Priority Created Status Action

1 day pop-up Popup | 1 1 All 5tore | Feb 2, 2021 Feb 2, 2021 Enabled Select -
reminder Views 5:31:53 PM 5:34:02 P

2 3 days pop-up Popup | 3 1 All Store | Feb 2, 2031 Feb 2, 2011 Enabled Select =
reminder Views 5:33:42 PM 5:33:42 PM

3 1 day email Email 1 1 All 5tore | Feb 2, 2021 Feb 2, 2021 Enabled Select -
reminder Views 5:35:00 P 5:35:00 P

4 5 days email Email 5 2 All 5tore | Feb 3, 2021 Feb 3, 2021 Disabled Select -
reminder Views 12:40:26 PM 12:40:26 PM

In the upper-right corner of the Reminders grid, click the New Email Reminder button to create a
new email reminder. The Reminders grid is empty during the initial setup.
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Email reminder: 5 days email reminder A demouser -

& Back Delete Reminder Reset Save and Continue Edit

FEeminder Information

Mame * | 5days email reminder

Internal name of the reminder. Visible in the back-end only.

Store Views * | All Store Views
Main Website

Main Website Store

Default Store View
o

This setting defines the store views, for which the reviews reminder should
be sent.

Customer Groups + | NOT LOGGED IN
General
Wholesale

Retailer
o

This setting defines the customer groups, for which the reviews reminder
should be sent.

Sent In, days * | 5 |

Personal Email Template | We want to hear YOU! [Default) v |

This email template will be used for the review reminder email.

Priority = | 2 |

The reminder with higher priority will be executed if seweral reminders
match at least one same condition [reminder type, customer groups, store
views, period).

Status Enable b

Disable

Under Reminder Information, do the following:

¢ In the Name field, enter the email reminder name. It is visible in the backend only.
¢ |In the Store Views box, specify one or more store views to send email reminders to. You can
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press and hold the ctrl key to select multiple options. Select All Store Views to enable the
functionality for all store views.

¢ |In the Customer Groups box, specify one or more customers to send the email reminder to.
You can press and hold the ctrl key to select multiple options.

¢ |In the Sent In, days field, specify the number of days after the order creation when the email
reminder should be sent.

¢ In the Personal Email Template box, click the Use config arrow to select a specific popup
email reminder template. By default, the We want to hear YOU! template is selected.

* In the Priority field, specify email reminders priority. If several email reminders match the
same condition, the one with higher priority gets sent.

e |n the Status box, click the Disable arrow to enable or disable the popup reminder. By default,
it is set to Disable.

In the upper-right corner, click the Save Reminder button.
Manage email reminder settings

If you want to make any changes in email reminders, you can make it by adjusting settings. It allows
you to specify email senders and to set an email template. Please, navigate to Stores -
Configuration - MageWorx -» Review Reminder.

Email Reminder Settings

Enable
Email Sender -

Review Reminder Emiail We want to hear YOU! (Defa. |
Template

template is chosen based on the

when the "Default” option i

e In the Enable field, select No if you want to disable email reminder. By default, it is set to Yes.

¢ In the Email Sender field, select the email sender from the list.

¢ |In the Review Reminder Email Template field, choose the email template. By default, it is
set to “We want to hear YOU!”.

In the upper-right corner, click Save Config.

Create and design a popup reminder

To collect customer feedback on the storefront, set up pop-up reminders. You can adjust popup
creatives as you wish. You can select one of the pre-defined templates or create a design of your
choice. Please go to Marketing -» Review Reminders - Manage Reminders. In the upper-right
corner of the Reminders grid, click the New Popup Reminder button.
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L demouser =

Popup reminder: 1 day pop-up reminder

« Back Delete Reminder Reset Save and Continue Edit

Reminder Information

Mame * | 1daypop-up reminder

Internal name af the reminder. Visibla in the back-end only

Store Views = | All Store Views
Main Website
Main Website Store

Default Store View
o

This setting defines the store views, for which the reviews reminder should be sent

Customer Groups = | NOT LOGGED IN

General

‘Wholesale

Retailer

P
This setting defines the customer groups, for which the reviews reminder should be
sant.
Displayed After, days #

This setting defines the numiber of days after the order creation, when the review

reminder can be display.

Display On Mobile Mo

This setting allows you to enable or disable the reminder, when the customers opan
your sbore on mobile davices.

Priority *
The remindar with higher priority will be executed if several remindars match the sama
conditions.
Status Enable v

Design

Templates

¢ In the Name field, enter the popup reminder name. It is visible in the backend only.

¢ In the Store Views box, specify one or more store views to display the popup in. You can press
and hold the ctrl key to select multiple options. Select All Store Views to display popup
reminders in all store views.
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¢ In the Customer Groups box, specify one or more customers to display the popup to. You can
press and hold the ctrl key to select multiple options.

popup reminder should be displayed.

By default, it is set to No.

Design

Content

Show / Hide Editor

=div

ss="mwns.-modal mwre-modal-layout-2 mwre-modal—
gyout-2-color-4 mwry-modal--open” tabindex="-1"

=div class="mwn-modal__dialog” role="document”=>
<div cla mwrv-modal__content”s
=div class="mwrv-modal__header”=
<button class="mwr-modal__close” type="button">

<svg width="18" height="18" viewBox="00 18 18"

<path d="M17 1L1 1701 1L17 17"
stroke="currentColor” stroke-width="2">=/path>
-.'."5'._,'5:-
</button=
=g
=div class="mwrv-modal_body™>
=h2 class="mwrv-modal__title">We want to hear
YOU</h2=
=div class="mwrv-modal__banner=
=div class="mwry-modal__banner-icon”
<svg fill="none" height="56" viewBox="0 0 68 56

-

o

In the Design tab, please do one of the following:

In the Display After, days field, specify the number of days after the order creation when the
In the Display On Mobile field, use the toggle to enable popup reminders on mobile devices.

In the Priority field, specify the display priority of popup reminders. If several popup reminders
match the same condition, the one with higher priority gets displayed.

In the Status box, click the Disable arrow to enable or disable the popup reminder. By default,
it is set to Disable.

¢ In the Content box, click the Show / Hide Editor button, and then insert the HTML code of
your own popup reminder design.

e Or on the right, click the Templates button to select one of the pre-built templates.
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Templates X
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e Click the option button of your choice, and then click the Load Template button to edit the
template. You can click Cancel to return to the Design settings.
¢ In the Content box, edit the content of the popup reminder as you wish. You can use the
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standard editor or click the Show / Hide Editor button to edit the HTML tags.

In the upper-right corner, click the Save Reminder button.

Manage popup reminder settings

If you want to make any changes in popup reminders, you can make it by adjusting settings. It allows
you to set product count for a popup. Please, go to Stores - Configuration - MageWorx -
Review Reminder.

Popup Reminder Settings
Enable

Max Products Count for
Popup

 In the Enable field, select No if you want to disable popup reminder. By default, it is set to Yes.
¢ |In the Max Products Count for Popup field, define the number of products count for a popup.
By default, it is set to 6.

In the upper-right corner, click Save Config.

Set UTM parameters

To track customers’ engagement, you can add UTM parameters to links and change them. Please, go
to Stores -» Configuration - MageWorx -» Review Reminder.

UTM Params
Add UTM Params
UTM Source
UTM Medium
LUTN Campaign
LITM Term

UTM Content

¢ In the Add UTM Params field, click Yes if you want to add UTM parameters. By default, it is
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set to No.
e Fill in the UTM Source, UTM Medium, UTM Campaign, UTM Term, and UTM Content
fields.

UTM Source is the variable that allows you to track where the traffic originated from.

UTM Medium is the variable for tracking the type of traffic the visitor originated from.

UTM Campaign is the variable that allows you to track the performance of a specific campaign.
UTM Term is the variable for tracking which keyword term a website visitor came from.

UTM Content is the variable that helps you track which link was clicked if you have multiple links
pointing to the same URL.

In the upper-right corner, click Save Config.

Manage unsubscribed customers

To track customers who opt to unsubscribe from review reminders, overview the unsubscribed
customers list. You can manually add customers to the list when required or following a request. To
view and manage unsubscribed customers please navigate Marketing - Review Reminders -
Unsubscribed Clients.

1

Unsubscribed Clients L. cemauser -
New Unsubscribed
W Filters 4> DefauliView - £¥ Colurrs -
Actions = 3 records found 20 T | pErpage 1 of 1
BE D | | Email Unsubscribed At Action
joei@example.com Feb 2, 2021 5:37:59 PM Delete
Zz mark@example.cem Feb 2, 2021 5:38:09 PM Delete
3 antony@example.com Feb 2, 20217 5:38:19 PM Delete

Manage action logs

To overview any interactions of the customers with email and/or popup reminders, use the Log grid
here: Marketing -» Review Reminders - Logs. It allows you to apply filters and quickly overview

amasty


https://amasty.com

2025/03/18 21:38 29/60 Guide for Marketing & Sales Suite by MageWorx for Magento 2

time-stamped information about all the set reminders, i.e., actions, customer emails, back-end
reminders names, email templates used, and more.

Configure reward points

This functionality allows you to build a powerful loyalty system and reward your customers for activity
in your store.

Reward points can be added to the customer account balance (i.e. for completing such actions as
placing an order, leaving a review, or subscribing for newsletters), as well as assigned to it on special
occasions (i.e.birthdays). Additional conditions can be applied so that the customer gains a reward
only if they are met.

The extension supports different methods of assigning the reward points, such as:

fixed number of points;

number of points for a specific amount spent;

number of points for a specific qty of items;

number of points for a specific amount/qty of items starting with a certain amount/qty.

The customers can check their reward points balance in the special tab of their customer account.
These points can be easily applied or canceled during the checkout.

General configuration

To configure the rewards functionality general settings, please go to STORES — Configuration —
MAGEWORX — Reward Points.

Under the Main Settings tab you can adjust the following:
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iMain Settings

Enable | . .
Static Block for "My Reward Points Se.ctli::-n Please select a static block .
Cover with the points
bsite Subtotal
Shipping
Tax
&

Points Exchange Rate

int in the Website Base Currency. Use the dot
Assign to Customer Groups o
hisite MNOT LOGGED 1M
General
Wholesale
Retailer
A
Allow Custom Points Amount No i
If enabled, your customers will be able to change amount of points they
Want 1D us= 1N e orders,
Annul the Received Points upon the Full Order | r 9
Refund L - —
a e Nis 52WINg allos 0D return e poInts the Customers reCense for the orders
n case of full order refund.
Return Spent Points in Case of Order Mo i
Cancellation
= If enabled, the points used O Tne Customers [0 plae an order will b=
credited back in case of order cancellation.
Time of Day for Birthday Gree1.:i|'.|g5 08 o 00 v |-| o0 o

The Enable setting provides the possibility to temporarily disable/re-enable the extension
functionality from the backend.

Static Block for “My Reward Points” Section sets a selected static block to be shown at My
Reward Points tab in the customer’s account. It supports all the blocks that are shown on the
CONTENT — Elements — Blocks grid.

Cover with the points allows applying credits to an order’s subtotal and/or shipping and/or tax. The
system analyses this selection and applies credits to what is chosen. For example, if the store owner
doesn't want to allow customers to pay shipping costs using credits, you need to remove the selection
‘Shipping & Handling’. Thus, customers will need to pay for shipping using other payment methods.
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Points Exchange Rate provides the possibility to change the cost of 1 Reward Point in the Website
Base Currency.

Assign to Customer Groups sets customer credit functionality to the selected customer groups. If
not selected, the customers won’t be able to use internal credits.

Allow Custom Points Amount - specify whether to allow or disallow customers to change amount of
points they want to use in the orders.

If the Annul the received points upon the full order refund is enabled, the reward points will be
removed from the customer account in case they were applied to the order that was refunded
afterward.

The Return Spent Points in Case of Order Cancellation configuration makes it possible to return
the points the customers received for the orders if the order has been canceled.

The Time of Day for Birthday Greetings specifies the time when the reward points will be added
on the customer’s birthday.

Under the Marketing tab you can adjust the following:
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iarketing

Display Header Message

[ztare view]

Header Message

[stare view]

Display Mini-cart Points Balance Message
[stare viaw]

Mini-cart Balance Message

[ztare view]

"Zero Balance" Message for Mini-cart

[stare view]

Display Cart Message

[stare view]

Cart Message

[stare view]

Display Checkout Message

[stare view]

Checkout Message
[stara view]

Add to R55 Feeds
[stare view]

Show Wrapper for Messages

[stare view]

Yes -

If enabled, the customers will see the message with a number of points they
will get if complete the order.

Complete this cart and earn [p] points for a discount on your 1

The message will be shown in the header. The following variables are
available: [p] - it will display the number of points the customer will receive
if completing an arder; [c] - it will display the reward value expressed in the
store CUrrency.

Yes -

If enabled, the customer's current points balance will be shown in the mini-
cart [if supported by a theme).

Your current reward points balance is [c].

The message will be shown in the min-cart. The following variables are
available: [p] - it will display the customer’s current balance expressed in the
points; [c] - it will display the customer’s current balance expressed in the
SLOME CUFTENCY.

Order now and get reward points for your future purchases.

The message will be shown in the min-cart if nothing is added to the cart
yat

Yes -

If enabled, the customers will see the message with @ number of points they
will get if complete the order.

Complete the purchase and eam [p] points for & discount ony

The message will be shown in the notice on checkout pages. The following
variables are available: [p] - it will display the number of points the
customer will receive if completing an order; [c] - it will display the reward
value expressed in the store currency.

Yes -

If enabled, the customers will see the message with @ number of points they
will get if complete the order.

Complete the purchase and earmn [p] points for a discount ony

The message will be shown in the notice on checkout pages. The following
variables are available: [p] - it will display the number of points the
customer will receive if completing an order; [c] - it will display the reward
value expressed in the store currency.

Mo -

Yes -

Add "Updated By” wrapper for manual update transactions’ messages.

Display Header Message - if enabled, the customers will see the message with a number of points

they will get if complete the order.
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Header Message - here you can specify the message, that will be shown in the header. The
following variables are available: [p] - it will display the number of points the customer will receive if
completing an order; [c] - it will display the reward value expressed in the store currency.

Display Mini-cart Points Balance Message adds the message to the mini cart popup.

This message is shown if the customer has the reward points in the account. The text can be changed
in the Mini-cart Balance Message field. The same variables can be used here as well.

X
12 ltems in Cart Cart Subtotal

£493.00

Proceed to Checkout
Compete Track Tote
“ £32.00

Qry: 2 & ﬁ

This message is shown if the customer doesn't have the reward points in the account. The text can be
changed in the “Zero Balance” Message for Mini-cart field:

Z Items n Cart Cart Subtotal :
$101.00
Crder now and get reward points for your future
purchases

Display Checkout Message - If enabled, the customers will see the message with a number of
points they will get if complete the order.

Checkout message will be shown in the notice on checkout pages. The following variables are
available: [p] - it will display the number of points the customer will receive if completing an order; [c]
- it will display the reward value expressed in the store currency.

Add to RSS Feeds - indicate whether to add or not the message to the RSS feed.

Show Wrapper for Messages - set to Yes if you want to enable wrapper for messages.
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Under the Email Settings tab you can adjust the following:

Email Settings

Email 5"_‘_'-":1__”. General Contact bt
Default Email Template for Balance Change In . .
P BE LY | Use the rule to update rewward points balance (Default) r
Rules
seE Thie email template is 1 based on the theme fallback when the
"Default” option is selected.
Email Template for Balance Change by .-'-'u.t.:lrr.'!u'! Update Reward Paints Balance By Admin (Default) -
The email template is chosen based on the theme fallback when the
"Default” option is selected.
Expiration Date Email Template ; - - h -
P _|_ .1 | ‘four Reward Points Balance will be expired soon (Defaull | =
Thie email template is chosen based on the theme fallback when the

"Default” option is selected.

Here you can specify the Email Sender, and choose the Templates for the following email types:

e Balance Change by Rules
e Balance Change by Admin
e Expiration Date Email

Under the Expiration Date Settings tab you can adjust the following:

Expiration Date Settings

Enable Expiration Date | .,

fes ¥
Default Expiration Period (days) 15
Update Existing Expiration Dates Mo .
Update the existing reward points expiration dates if the "Default Expiration
Period” is changed. Works only if the expiration dates functionality is
enaoled
Send Expiration Date.l?.r'n?!! N .

If Enabled, these settings provide the possibility to give the rewards points the expiration period. The
store owner may change this time interval by giving the number of days for the rewards points in the
Default Expiration Period configuration block.

The situation when the store owner decides to change or enable the expiration date settings is quite
possible. The logic of such store points management is configured in the Update Existing
Expiration Dates setting.
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e If No is selected, the customers with both expired and not expired balances the new expiration
period won't change. It will be changed for them only in case some new reward points will be
added to their account.

e If For balances if expiration date exists setting is selected, this new expiration period will be
changed only for those customers who have some points available with the expiration date set
in their customer account. All of them will be able to use their points during the time interval
that was defined in the Default Expiration Period setting.

e If For all balances setting is selected, this new expiration period will be changed for all the
customers, even for those that don’t have the expiration date set in future in their customer
account.

The Send Expiration Date Email setting allows sending the emails about the approaching
expiration date. The number of days to send the messages before the actual expiration can be set up
in the Notify Customers about Expiration Date configuration.

Reward points rules

To add, delete or modify the Reward Points rules, go to Marketing — MageWorx Reward Points
— Rules.

I demaouser =
Reward Points Rules i
Add New Rule
W Filters > DefaultView - £ Coumns -
Actions = 5 records found 20 * | per page ’ of 1
Times Points = Stop Rules =
BE D ! | Name Event Used Cenerated Priority Processing Status Action
Extra bonus for each | Placed order & 150.0000 a Mo Enabled Select =
$100 spent
2 Thank you for leaving | Customer 1 5.0000 1 Mo Enabled Select -
a review! review
3 Happy Birthday! Customer a 0.0000 2 Mo Enabled Select -
birthday
B Thank you for Customer ] (0.0000 1 Mo Enabled Select -
registraticn! registration
3 Thank you for placing | Placed order 1 15.0000 3 Mo Enabled Select -
the order!

Please note that during the initial setup this grid will be empty. To create a new reward points rule
click the Add New Rule button. The rule configuration consists of 4 sections.
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Rule Information

Rule Information

Rule Mame * | Extra bonus for each $100 spent
Description
i
Active ¥ ( Yes
Websites = | Main Website
S
Customer Groups * | NOTLOGGED IN
General
Whaolesale
Retailer
S
From 0272202
To
Priority 0
Allow Motification ( Yes
Personal Email Template Use config -

Publicin RSS Feed @ ) Ves

Rule Name allows you to assign a unique name to the created rule.

The Description field provides the possibility to add the rule description. It will be visible only in the
back-end.

The store owner can temporarily disable or re-enable the rule using the Active toggle.
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The Websites setting specifies the website where the rule should be applied to.
The Customer Groups configuration allows applying the rule to the specific customer groups only.

The store owner can restrict the usage of the rule by date intervals using the From and To date
pickers.

If several rules can be applied and their priority needs to be handled, it can be managed by the
Priority setting. The bigger the value, the higher the rule will be in the order of priority.

If Allow Notification is enabled, then the email will be sent to the customer when the reward points
are credited to the balance.

Personal Email Template adds the possibility to use the template that meets exactly this particular
rule. If the Use Config setting is selected, the one in the extension configuration will be picked.

Actions
The extension supports the following events to reward your customers:

 Place order

e Customer birthday

e Customer registration
e Product review

e Newsletter subscription

For all events you can set the amount of points you want to reward your customers with if the rule is
triggered:

Actions ~

Event Customer registration s

Points Amount {Get X Points) =

Stop Rules Processing Mo

The order placing configuration is more complicated and needs to be explained.
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Actions ~

Event Placed order -
Give Points et X Points for every ¥ spent -
Calculation Type Fixed -
Points Amount {Get X Points) = | 10
¥ spent 100

tregulates the amaount a customer must spend ta get "X points”. "X points” are assigned each
time the customer spends the set amount.

Stop Rules Processing Mo

Placed Order

Event Placed order -

Give Points [ECEI®. S0 J

Get X Points for every Y spent

Get X Points for every Y spent starting from Z spend

Get X Points for every Y quantity

Get X Points for every Y quantity starting from Z quantity

If the “Placed Order” event is selected, the “Give Points” setting shows. It can be further configured
depending on the desired condition.

1. The Get X Points setting allows crediting the specific (X) number of reward points to any order.

2. The Get X Points for every Y spent credits the specific (X) number of reward points to the order
that is bigger than Y threshold. So, for instance, the X = 10 and Y = 50.
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549 0
552 10
599 10
5101 20

If the grand total is $49, then the customer doesn't receive any reward points, for the grand total $52
the customer receives 10 reward points. The customer gets 10 points as well if the grand total is $99.
For $101, the customer receives 20 reward points, and so on.

3. The Get X Points for every Y spent starting from Z spent credits the specific (X) number of
reward points to the order that is bigger than Z threshold for every Y sum. So, for instance, the X =
10, Y =20 and Z = 100.

509 0
5119 0
5139 10
5141 20

If the grand total is $99, then the customer won't receive the reward points as it is smaller than Z
($100). If the total is $119, then the customer won't receive the reward points as well, because 10
points are credited for every $20 starting from $100 and $119 is less than $120. If the total is $139,
then 10 reward points will be credited to the account. 20 reward points will be added for the $141
grand total, and so on.

4. The Get X Points for every Y quantity credits the specific (X) number of reward points to the
order that has more than Y products in sum. So, for instance, the X =10 and Y = 5.
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T-shirts Quantity Bags Quantity Pencils Quantity Total Quantity Reward Points

3 1 0 J3+1=4 0
5 4 0 5+4=0 10
7 3 | 7+3+1=11 20

If the customer buys 3 T-shirts and 1 bag, then no reward points will be added as the total quantity 4
is less than Y. If the customer buys 5 T-shirts and 4 bags, then 10 reward points will be added (total
quantity is 9). For the order with 7 T-shirts, 3 bags and one pencil 20 points will be added (total
quantity is 11).

5. The Get X Points for every Y quantity starting from Z quantity credits the specific (X) number of
reward points to the order that has more products than Z threshold for every Y products. So, for
instance, the X =10,Y =5 and Z = 10.

T-shirts Quantity Bags Quantity Pencils Quantity Total Quantity Reward Points

4 5 0 445=9 0
4 5 5 4+5+5=14 0
4 4 8 4+4+8=16 10
7 9 5 7+0+5=21 20

If the customer buys 4 T-shirts and 5 bags, then no reward points will be added as the total quantity 9
is less than Z (10). If the customer buys 4 T-shirts, 5 bags and 5 pencils, then the customer won't
receive the reward points as well, because 10 points are added for every 5 products starting from 10
and the total quantity (14) is less than 15. If the customer purchases 16 products in total, then 10
reward points will be added to the account. 20 reward points will be added for the 21 products in
total, and so on.

The “Placed order” event shows the additional field, the Calculation Type so that the quantity of
reward points can be calculated as the fixed value or as the percent of the grand total.

The last, “Stop Rules Processing” configuration stops any other reward points rules from being
processed in case several rules conditions are met.
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Apply the rule anly to cart items matching the following conditions (leave blank for all items).

f the action conditions are empty - the price will be calculated from the cart subtotal with discount If the action
© conditions exist and include the valid items - the amount will be calculated using the valid itermns' price and gty. If the
action conditions exist and don't include the valid items - the rule will e ignored.

f ALL of these conditions are TRUE

Category is | &

This section limits the products from the whole cart that should be counted. If you have several
products in the cart, and only one meets these conditions, it will be handled as if it had been the only
one in the cart. If the action conditions are empty, the price will be calculated from the grand total (no
rules = no limitations). If the action conditions exist and don't include the valid items, the rule will be
ignored and not shown at all.

Conditions

This workspace has the same structure and logic as the previously described Actions section. The
difference is that these condition limits the whole cart so that if the condition is true, the reward
point rule will be met. After that, the extension will check the valid products (if any) from the
Actions tab. Otherwise, the rule will be ignored and not shown at all.

Leave conditions empty to reward your customers for purchasing all products.

Labels

Labels »

Default Rule Label for All

el frr making am Arder]
Stare Views Thank you for making an order!

Store View Specific Labels (7]

Main Website

Main Website Store

Default Store View Thank you for making an arder!

The Labels Section is designed for different frontend names of the reward points rule on different
store views. Some rules may need to be translated and, for this matter, this section allows specifying
the appropriate name. Please note that if the string is empty, the Default Rule Label for All Store
Views will be used.
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Customer Information

Please, go to Customers — All Customers. The extension adds a special tab that shows the current
reward points balance directly on the grid:

d Ser -
Customers L. demousr
Add New Customer
Search by keyword Q ¥ Filters € DefaultView - ﬂ- Columns - oy Export -
Actions = 5 records found 20 * | perpage 1 of 1

Phane Customer Since | Confirmed email

Veronica roni_cost@example.com | General | (555) 229- 4%628- | United Sep 16, 2020 Confirmation Not |§ 2.0100 Edit
Costello 3326 7978 States 11:43:41 AM Required

2 John White white@example.com General | +3589252462 12324 | Turkey Feb 2, 201 Confirmation Not |§ 0.0000 Edit
5:52:42 PIA Required

3 Anna Bond anna@example.com General | +3589252462 12324 | Turkey Feb 2, 201 Confirmation Not § 95.0000 Edit
7:06:32 P Required

4 Jirm jimi@example.com General | +3589252462 12324 | Turkey Feb 3, 2021 Confirmation Mot |§ 20.0000 Edit
Newcastle 10:57:34 AM Required

5 John Doe doe@example.com General | +35458252462 | ABIC United Feb 3, 2021 Confirmation Mot |§ 10.0000 Edit
2DF Kingdam 12:30:01 PM Required

Select the customer whose balance you need to edit. The customer reward points are shown on the
special Reward Points tab.
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Veraonica Costello

+« Back

CUSTOMER INFORMATION

Customer View

Delete Customer

Reset Create Order

L demouzer «

Save and Continue Edit

Reward Points Balance

Website

Balance Curmency Amount

Expiration Date

ain Websita 2.0100 $2.01 2021-02-17 {12 days kefi)

Account Information

Addresses
Update Reward Points Balance
Orders
store Default Store View -
Mewsletter
Update
Paoints

Billing Agreaments : : : :
EfE It is poesible to use a negative variable when subtracting points.

Product Reviews Mew Expira- o
tion Period -
- remains unchanged. Leave empty for the set unlimited expiration data.
Wish List For reference: The *Default Expiration Period” is 15 days.
) cemnd N
Reward Points Notification o =
Motifications are sent only in case of the points balance changas.
Comrment for
Customer
Reward Points Transactions =

m Reset Filter

Balance | Poimis | Website

% records found 20 * | perpage 1 of

Event Message Created

v '

]| -10.41 Main Websita Feb 2, 2021, £:59:02 PM
12.42 -12.58 1 Main Website Feb 2, 2021, &:57:55 PM
5 +10 Main Wehsite e added for the completed Feb 2, 2021, &:56:06 PM
15 +5 Main Website | For submitting of the review Feb 2, 2021, 6:45:33 PM

The Reward Points Balance tab shows the grid with the customer's reward point balance on any
website within one Magento installation. If the expiration period has been enabled, it will be shown
here as well.

amasty


https://amasty.com

Last update: 2021/02/09

15:51 magento_2:marketing_automation https://stg.amasty.net/docs/doku.php?id=magento_2:marketing_automation

The Reward Points Transaction tab shows the grid with the customer's reward points transactions
history.

Update Reward Points Balance

Store Default Store View v

Main Website
Main Website 5tore

Update Points Default Store View

t is possible to use a negative variable when subtracting points
Mew Expira -~
tion Period -
remains unchanged. Leave empty for the set unlimited expiration date.
For reference: The "Default Expiration Period” is 15 days
S5end - =
Motification -
Motifications are sent only in case of the points balance changes.
Comment for
Received

Customer

The Update Reward Points Balance tab provides the possibility to manually credit or deduct the
reward points.

The Store configuration provides the possibility to add the points to the customer in the specific store
view.

The Update Points supports both positive (to credit) and negative (to deduct) values.

The store owner can specify the New Expiration Period. Please note that in case the customer
already has some available reward points (both without and with the expiration date set), the new
period will be applied to them as well.

If the Send Notification is set to Yes, the customer receives the email with the default email
template.

The Comment for Customer allows the store owner to write some particular text for the customer
to be visible in the customer account.

Point transactions

To observe the full log of the transactions made by your customers, go to Marketing — MageWorx
Reward Points — Point Transactions.
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Points Transactions L. cemouser -
W rilters €C» DefaultView - £} Coumns - oty Ewport -
14 records found 20 * | perpage 1 of 1

Points

Event Code Created At
Balance

Customer Email

roni_cost@example.com | +10.0000 10,0000 order_placed_earn Main Feb 2, 2021
Website 15:40:20

2 roni_cost@example.comn | +5.0000 15.0000 CUSTOMEr_review Main Feb 2, 2021
Website 15:45:33

3 roni_cost@example.com | +10.0000 25.0000 order_placed_earn Main Feb 2, 2021
Website 15:56:06

B roni_cost@example.com | -12.5800 12.4200 order_placed_spend Iain Feb 2, 2021
Website 15:57:55

5 roni_cost@example.com | -10.4100 20100 order_placed_spend hiain Feb 2, 2021
Website 15:59:08

6 anna@example.com +10.0000 10.0000 order_placed_earn Iain Feb 2, 2021
Website 16:09:07

7 anna@example.com +10.0000 20.0000 order_placed_earn Main Feb 2, 2021
Website 16:11:19

B anna@example.com -17.0000 3.0000 order_placed_spend Iain Feb 2, 2021

Website 16:11:42

Import/Export reward points

To import or export reward points, please, go to System — Data Transfer — Import/Export
Reward Points.
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Import and Export Reward Points Balance

O make sure your file isn't mare than 10M.

Import Reward Points Balance Cheese File | NO file chosen Import Reward Points Balance
Export Reward Points Balance Export Reward Points Balance
Download example CSV file Dowrload

To check the structure of the reward points, click the Export Reward Points Balance button or the
Download Example CSV. The CSV structure is as follows:

"Website Code","Customer Email","Points","Action","Comment for Customer (not
required)”

"base","rewrite balance@example.com","20","replace","Hello! Your balance now
is 20 points"

"base","add to balance@example.com","10","add","Hello! 10 points were added

to your balance"
"base", "deduct from balance@example.com","5","deduct"”,"Hello! 5 points were

deducted from your balance"

The action column manages the balance change. For instance, assume that the original balance is
100 and the value of the number points is 25.

e The replace value changes the customer's balance to the exact value of points (25)
e The add sums the number of points to the original one (100+25=125)
e The deduct subtracts it (100-25)=75.

If the deduct value is bigger than the original one, the final value will stay 0.

Customer account

The customer reward points are shown on the special Reward Points tab on the customer
information page.
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Reward Points

Reward Points Balance

You have 2.01 Reward Points ($2.01). Expiration date is 17-02-2021.
Reward Points Transactions

5 ltermis)chow | 10 « | per page

Balance Points Message Date

20100 -10.4100 Points were used for the order 000000009 2/2(27, 659 PM
124200 -12.5800 Points were used for the order 000000003 2/2{21, 657 PM
25,0000 +10.0000 The reward points were added for the completed order 000000007 222, 6:56 PM
15.0000 +5.0000 For submitting of the review 2221, 6:45 P
10,0000 +10.0000 The reward points were added for the completed order 000000006 212021, 640 P

5 ltemis)show | 10 « | per page

Here, the customer can observe the exact quantity of the reward points and the reward point
transactions history. The expiration date, if enabled, is shown here as well. The comment for
customer from the backend is shown in the Message column.
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O Luma
v _®_

Shipping Review & Payments

A Complete the purchase and earn 40 points for a discount on your future purchases,

Payment Method

Check / Money order Order SUFﬂmal’y

My billing and shipping address are the same Cart Subtotal $493.00

Weronica Costello Discount -$92.00

6146 Honey Bluff Parkway Shipping $0.00
Best Way - Tahl

Calder, Michigan 49628-7978 st ey - labie
Rate

United States

(535) 229-3326

Tax £33.08

Order Total $434.08

Place Order
12 ltems in Cart ~

Ship To: s

Apply Discount Code  w

Reward points
Veronica Costello

You have 2.01 Reward Points ($2.01)
65146 Honey Bluff Parkway

Applyr MY Reward Points Caldel’r i iChigal‘l 49628-7978
United States

(555) 229-3326

The extension shows the Reward Points block on the checkout with the possibility to apply them to
get the discount.
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Reward points

@ The reward points have been successfully applied.

You have 2,01 Reward Points ($2.01)

Cancel Reward Points

The customer can cancel the usage of the reward points usage if necessary.

If the customer doesn't have any reward points at all, this block will be hidden.

Configure personal customer discounts

Backend setup

Please, go to Stores — Configuration — MageWorx — Personal Customer Discount.
MageWorx Personal Promotion

Enable Personal Promotions

: Yas b
In Cart Price Rules

The Enable Personal Customer Discount in Cart Price Rules setting provides the possibility to
temporarily disable/re-enable the extension functionality directly from the backend.
Personal customer discount configuration

The extension extends the default cart price rules configuration.

To edit the cart price rule, the store owner should go to Marketing — Promotions — Cart Price
Rules.
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Cart Price Rules A Marketingsuite +

Add New Rule
Reset Filter 4 records found 20 * | perpage | of 1

Web Site Priority

From From

Ta Ta . s

A Ifs‘;;:r__:‘;;;’:"ater botde g Feb24,2021 | Feb25,2021 | Active | el 0

2 cPend SOOI~ FreeShipping  Feb 10,2021 Feb 16,2021 ctive  Main 0
shipping is free! Website

3 E?u: ;’LF"_F: e ]an21,2021 | Feb17,2021 | Acive | el 0
:zfr feeshrsand | 3hirts Coupon | Feb 5, 2021 Feb27,201 | Acive | pan

From here, the store owner can either Add New Rule or Edit the rules that have been created before.
Please note that during the initial setup this grid may be empty.

Our extension adds the special Customers tab.
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$4 Luma water bottle (Save 70%) « Back Delete Reset Save and Continue Edit ﬂ
Conditions )
Actions ©
Labels @)
Manage Coupon Codes @
Customers @
m Reset Filter 6 records found 20 v  perpage 1 of 1

=} Customer ID T | Name Customer Emall Country Website
Any ¥

6 Sergey s.uchuhlebov@mageworx.com United States MageWorx
5 Vitaly v.gonkov@mageworx.com MageWorx
4 azalescky a.zalescky@mageworx.com MageWorx
3 vitali vitali@mageworx.com MageWorx
2 test artemzalescky@gmail.com MageWorx

Veronica roni_cost@example.com United States MageWorx

This tab shows the customers grid with the default possibility to sort out the values and reset the
filters. The customer grid supports the multiselect possibility to choose several customers
simultaneously. Once the customer(-s) are selected and the configuration is saved, the cart price rule
will be triggered only for the targeted shopper(-s).

Note: if no customers are selected, the cart price rule will work for anyone

Personal customer discount features in Magento 2 Enterprise

Magento 2 Enterprise edition provides the possibility to add scheduled updates. Cart price rules can
be applied on schedule as part of some campaign.
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$4 Luma water bottle (save 70%) Q 40 4 emin-

Scheduled Changes

€ Back Delete Reset Save and Continue Edit m

Currently Active

Rule Information (

[©)

Rule Name * | $4 Luma water bottle (save 70%)

Description Use promo code H20 at checkout

Active * ( Yes
To add the new schedule update, click the Schedule New Update button.
Once the schedule update has been created, the store owner should click the Save button.

The upcoming update will be shown in the scheduler.

$4 Luma water bottle (save 70%) Q M@ L snin-
Scheduled Changes
Jul 4, 2018 6:00 AM Start  New Schedule View/Edit | Preview
Aug 25,2018 3:53AM  End

Configure product countdown timers

Product Countdown Timers module is designed to add the urgency and scarcity for your customers to
motivate them to purchase

Backend Setup

Go to Stores — Configuration — Mageworx — Marketing Suite — Countdown Timers.
Currently, there is only one setting here for now:
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Countdown Timers

This setting allows you to enable or disable the countdown timers globally on the front-end. To add or modify the timers, go to
Marketing - Countdown Timers.

Enable | . __
[sbore view] =
Enable - it enables/disables the entire functionality on the front-end.

Manage timers

In order to add or edit countdown timers, navigate to Marketing — Marketing Suite —
Countdown Timers.

Countdown Timers L Marketingsuite ~

W Filters > DefaultView - £ Coumns -

Actions = 4 records found 20 * | perpage ’ of 1
BE D ! | Name Store View Start End Status Priority | Action
Fusion Backpack All 5tare Views Feb 3, 2021 Feb 26, 2021 Enable 1 Select -
2 Push It Messenger Bag All 5tare Views Enable 2 Select ~
3 Cwernight Duffle All Store Views Jan 19, 2021 Jan 21, 2021 Enable a Select -
4 Watches (by condition) All Store Views Feb 17, 2021 Feb 27, 2021 Enable 0 Select -
e Name - the internal name of a campaign. Visible in the back-end only.
» Store Views - the store views, a campaign is assigned to.
 Start/End - these dates determine the start and end dates when a certain timer should be

shown and hidden. The timer will show the remaining period from start to end dates.

Status - the current status of a campaign.

Priority - the priority for each campaign. The campaign with higher priority will be shown first if
multiple timers match the same conditions.

To add a new timer click on the Add new timer button.
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Fusion Backpack

COUNTDOWN TIMER
INFORMATION

General

Products

Design

& Back

General

Mame +

Status

Store Views *

Customer Groups *

Display mode

Display on
Categories

Use discount dates

Start +

End *

Priority

The General section of the timer:

e Name - the internal name of the timer. It is visible in the back-end only.

e Status - the status of the timer.

Delete Timer

Fusion Backpack

Enable v

All Store Views
Main Website
Main Website Store

Default Store View

MNOT LOGGED IMN
General
Whaolesale

Retailer

Specific products | =

( Yes
Mo
02/3/2021 =

02/26/2021

L MarketingSuite -

Save and Continue Edit m
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e Store View(s) - you can choose the store views you want to display the timer on.

e Customer Groups - you can choose the customer groups you want to display the timer for.

» Display Mode - this setting defines the products, the timer should be shown for. You can
choose to display the timer on all products, specific products or to use custom mode. If you
select the 'custom' mode, such timers can be used in Magento 2 widgets to display the timers in
any custom place of your store.

» Use discount dates - this toggle defines whether the timer should use the start/end dates of
the product special price or matching catalog price rule (if applicable).

Example

Let's assume you created the timer with the enabled 'Use discount dates' toggle and applied it to the
productA. This product has a special price valid within 3 days and it matches the conditions of one of
the catalog price rules valid within 7 days. In this case, the timer will use the start/end dates of the
special price first. When the current date passes the end date of the special price (i.e. when the
special price expires), the timer automatically will start using the matching catalog price rule.

The product special price has higher priority than the catalog price rule if both discounts are applied.

e Start/End dates - these dates are enabled if the 'Use discount rates' is disabled. These
settings set the date when the timer should be activated, and the date when it should be
hidden. The timer will display the remaining period from the start to the end date.

e Priority - this setting defines the priority of each timer if multiple timers have the same
conditions. The timer with higher priority will be executed.

If Specific products is chosen in the Display mode, the Products tab appears to choose the
products you need to apply the timer to.
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BagS Sale .l.. demaouser =

< Back Delete Timer Save and Continue Edit m

COUNTDOWN TIMER Products
INFORMATION

General Assign Type Specific products |

Products Specific products

Design

20 * | perpage 1 of 1
ID | Thumbnail Name Status ;‘:E"h“te SKU | Price | Actions
- Fusion Enabled | Bag 24 Remove
‘ Backpack MEQ2
- Compete Enabled ' Bag 24- Remoaove
“ Track Tote WB02

The Design tab allows you to choose a design template for the timer.
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Bags Sale L. cemouser +
<« Back Delete Timer Save and Continue Edit m
COUNTDOWN TIMER Des ign
INFORMATION
General Before timer text Limited offer: 50% off]
Products After timer text Catch nowl
Design

Templates

The sale will end in

Preview: | |
212):(2]2):1]2):1]3)

» Before timer text - this field allows you to specify a text, which will appear above the timer on

the front-end.

o After timer text - this field allows you to specify a text, which will appear below the timer on

the front-end.

The Templates button opens the gallery of ready designs for your timers:
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Templates X

Cancel Load Template

The sale will end in The sale will end in
1 1
1 2': 1 2(:/11/2 :|1-£I :::
The sale will end in The sale will end in
O #3 | QO #4 |
The sale will end in The sale will end in
2.02:92 52 02090000
O #s ﬂ' Ots v
The sale will end in The sale will end in
os T om0 -
The sale will end in The sale will end in
CoR CH R :::
day hrs min e day hrs min SEC
() 9 ) #10

The Custom value in the Display mode setting allows you to add a timer to a widget. The widgets
can be added to any custom page in your store and to any custom position within the page. To add
and manage widgets. please navigate to Content — Widgets — Add new widget.
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Countdown timers frontend examples

Fusion Backpack

ey 3 Reswd A Your REass
ik STOOK

$49.00
Repgular
Price
3552.0

The sale will and in
2888

Hurry up!

Qrey

1
# This produet wirs [ R L foe last day
W ADD TO WISH LIST i ADD TO COMPARE
Didi Sport Watch
o ) 2 Rrviews Add Your Heview

N STOCK
$73'EU SHLUE: 24-WG02
Reoular
Price
$92.00
Sale will end in

o e of: o >

T eyt
Qry

1

Add to Cart

# This prosuct was m foe last clay

W ADD TO WISH LIST «l ADD TDO COMPARE

Find out how to install the Marketing & Sales Suite extension for Magento 2 via Composer.
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